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1-BILET
1. MS Word dasturida hujjatlarda rasmlar, shakllar va sxemalar bilan ishlashni
tushuntiring.
MS Word dasturi, hujjatlarda rasmlar, shakllar va sxemalar bilan ishlashni osonlashtirish
uchun bir gancha qulay funksiyalarga ega.
Rasm kiritish. MS Word dasturida, menyudan Insert -> Picture -> From File tanlovini
belgilab, kompyuteringizda saqlangan rasmlarni hujjatga qo'shishingiz mumkin. Qo'shilgan
rasmlar matn ustida joylashadi va ularni rejasiga mos foydalanish mumkin.
Shakl kiritish. Shakllar, MS Word dasturida bajarish uchun "Insert" -> "Shapes"
funksiyasidan foydalanishingiz mumkin. Bu funksiya orqali, turli turdagi shakllarni, masalan,
kvadrat, aylana, triangel va boshqalarini chizishingiz mumkin. Shu bilan birga, shaklga rang,
qalinlik, cho'zilishlar va qo'shimcha tahrirlar kiritishingiz mumkin.
Sxemalar kiritish. MS Word dasturida, "SmartArt" funksiyasi orqali turli turdagi sxemalar
qo'shishingiz mumkin. "SmartArt" funksiyasiga kirib, siz turli turdagi sxemalarni tanlay
olasiz, masalan, hierarxiya, sikl va boshgalar. Sxemalar, haqiqiy hayotda, ma'lum bir
konseptni tasvirlaydigan ko'p qator obyektlarni o'z ichiga oladi, va bu obyektlarni taxminan
har xil ranglarda ranglashingiz mumkin.
MS Word dasturi orqali, matndagi rasm, shakl va sxemalarni kiritish, tahrirlash va tuzish juda
oson. Buni qulaylik, tezlik va sodda bilan amalga oshirishingiz mumkin.
2. “O‘zbekiston — mening Vatanim™ jumlasini veb-sahifaning o‘rtasida yashil rangda,
tag chizigli ko‘rinishda 2-marta chigaruvchi HTML kodni yozing.
<html>
<head>stitle>1-bilet @ustoz</title> </head>
<body>
<font size=5>1 - bilet
<br>
<p align=center><hl><font color="green"> <u>Q0 zbekiston — mening Vatanim
<br>0 'zbekiston ~ mening Vatanim
</u></font></p>
</body>
</html>
3. Maymun banan yeyapti. Uning har bir qo‘lida 111(2) banan, har bir oyog‘ida esa
go‘lidagidan 1 ta ko‘p banan bor. Maymunda nechta banan bor? Javobni 3 lik sanoq
sistemasida yozing.

11192 + 112y -2 = 222 +224 = 446
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Javob: 1211125

2-BILET
1. MS Word dasturida matn yozish qoidalari va hujjatlarning asosiy parametrlarini
tushuntiring.
MS Word dasturi, matn yozish uchun bir gancha qulay funksiyalarga ega. Matn yozish



qoidalari va hujjatlarning asosiy parametrlari quyidagicha:
Shrift va o'lchamlari: Matn yozishda odatda shirft tanlovi juda muhimdir. MS Word
dasturida, menyudan "Home" -> "Font" orqali, shirftni tanlash mumkin. Shu bilan birga,
shirftning o'lchamini ham o'zgartirishingiz mumkin.
Matn ustiga rang qo'shish: MS Word dasturida, menyudan "Home" -> "Text Highlight
Color" orgali, matn ustiga rang qo'shishingiz mumkin. Shu bilan birga, matning qalinligi va
xaromini ham o'zgartirishingiz mumkin.
Sarlavha kiritish: Hujjatlarda, sarlavhalar kiritish juda muhimdir. MS Word dasturida,
menyudan "Insert" -> "Header" yoki "Footer" tanlovini belgilab, sarlavhalar va quyidagi
yozuvlar qo'shishingiz mumbkin.
Bo'limlarni ajratish: Hujjatlarda, bo'limlarni ajratish ham juda muhimdir. Bu, hujjatni
osonroq tushunarli va qulay giladi. MS Word dasturida, menyudan "Page Layout" -> "Breaks"
-> "Next Page" orqali, bo'limni ajratishingiz mumkin.
Matn ustiga belgi go'shish: MS Word dasturida, menyudan "Insert" -> "Symbols" orqali,
turli turdagi belgilar go'shishingiz mumkin, Bu belgilar, matning ma'nasini yoritish uchun
kerak bo'lishi mumkin.
Matnning ko'rish tartibi: Hujjatlarda, matnning ko'rish tartibi ham juda muhimdir. Bu,
hujjatni osonroq tushunarli va qulay qgiladi. MS Word dasturida, menyudan "Page Layout" ->
"Orientation" -> "Portrait" yoki "Landscape" tanlovini belgilab, matning ko'rish tartibini
o'zgartirishingiz mumkin.
MS Word dasturi, matn yozish uchun bir qancha qulay funksiyalarga ega. Bu funksiyalar
orqali, matnni qulay va tushunarli tahrirlash va formatlash mumkin.
2. 120 sonidan katta bo‘lmagan barcha juft sonlar yig‘indisini hisoblovchi dastur
tuzing.
n=120
total = 0
for i in range(2, n, 2):

total += i
print("Katta bo'lmagan juft sonlar yig'indisi:", total)
3. Quyidagi ifoda qiymatining ikkilikdagi ko‘rinishida_nechta bir ragami_mavjud:

2333(4)+10001(2)-A0(16)?
2333, = 10011011011, BARCHA IMTIHON JAVOBLARINI
10001, = 10001, T.ME/USTOZ TELEGRAM KANALI
ORQALI YUKLAB OLING!

Aols = 10100000‘
10011011011, + 10001, - 10100000, = 10011101100, - 10100000, = 10001001100,
Javob: 4 birlik

3-BILET
1. MS Word dasturida hujjatlarni tahrirlash va formatlash hagida ma’lumot bering.
MS Word, hujjatlarni tahrirlash va formatlash uchun bir gator qulay funksiyalarga ega. Bu
funksiyalar orgali, hujjatlarni qulay va tushunarli tahrirlash va formatlash mumkin.
Quyidagi funksiyalar MS Word dasturida hujjatlarni tahrirlash va formatlashda foydali bo'ladi:
Matnni formatlash: MS Word, matnni shirft, o'lcham, galinlik, ustunlik va boshqa
ko'rinishlarga moslashtirish uchun bir gancha funksiyalarga ega. Bu funksiyalar orqali, matnni
formatlash va uni ko'rishni qulaylashtirish mumbkin.
Hujjatning sarlavhasini belgilash: Hujjatlarda, sarlavhalar kiritish juda muhimdir. MS Word



dasturida, menyudan "Insert" -> "Header" yoki "Footer" tanlovini belgilab, sarlavhalar va
quyidagi yozuvlar qo'shishingiz mumkin.

Rasmlarni va shakllarni kiritish: Hujjatlarga rasmlar va shakllar kiritish, ularni tartiblash va
ularga ko'rsatmalar qo'shish kerak bo'lishi mumkin. MS Word dasturida, menyudan "Insert" -
> "Picture" orqali, rasmlar va shakllar qo'shishingiz mumkin,

Hujjatlarni ajratish: Hujjatlarda, bo'limlarni ajratish ham juda muhimdir. Bu, hujjatni
osonroq tushunarli va qulay giladi. MS Word dasturida, menyudan "Page Layout" -> "Breaks"
-> "Next Page" orqali, bo'limni ajratishingiz mumkin.

Matn ustiga belgi qo'shish: MS Word dasturida, menyudan "Insert" -> "Symbols" orqali,
turli turdagi belgilar qo'shishingiz mumkin. Bu belgilar, matning ma'nasini yoritish uchun
kerak bo'lishi mumkin.

Qayta ishlash: MS Word, hujjatlarni qayta ishlash uchun ko'p funksiyalarga ega. Bu
funksiyalar orqali, o'zgartirilgan hujjatlarni qayta ishlash va ularni eskisiga qaytarish mumkin.
MS Word dasturi, hujjatlarni qulay va tushunarli tahrirlash va formatlash uchun bir gancha
qulay funksiyalarga ega. Bu funksiyalar orqali, hujjatlarni qulay va tushunarli tahrirlash va
formatlash mumkin.

2. “Bilim insonga kuch beradi” jumlasini veb-sahifada ko‘k rangda harakatlanuvchisatr
ko‘rinishida chigaruvchi HTML kodni yozing.

<p><span style="color: blue; text-decoration: underline; animation: my-animation 1s
infinite;">Bilim insonga kuch beradi</span></p>

<style>
@keyframes my-animation {
0% { transform: translateX(0); }
50% { transform: translateX(5px); }
100% { transform: translateX(0); }
}
</style>
3. Bog‘da 100(q) ta mevali daraxt bor. Ularning 33(q) olma, 22(q) tasi nok, 16(q) tasi olxo‘ri
va 17(q) tasi olcha daraxtlaridan iborat. Daraxtlar sanab o‘tilgan sanoq sistemasining asosini
toping.
33,+22, 416, +17, =100,
3.t +3.q°+ 2.q° + 2.q° + 1-q' + 6-q° + 1-q* + 7-q° =1-q° +0-q° + D-¢°
Iq+3+2q9+2+q+6+q+7=¢
a’+7q+18=0
e g8 BARCHA IMTIHON JAVOBLARINI
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Javob: 9

4-BILET
1. MS Word dasturida hujjatlarda rasmlar, shakllar va sxemalar bilan ishlashni
tushuntiring.
MS Word dasturi, hujjatlarda rasmlar, shakllar va sxemalar bilan ishlashni osonlashtirish
uchun bir qancha qulay funksiyalarga ega.
Rasm kiritish. MS Word dasturida, menyudan Insert -> Picture -> From File tanlovini



belgilab, kompyuteringizda saqlangan rasmlarni hujjatga qo'shishingiz mumkin. Qo'shilgan
rasmlar matn ustida joylashadi va ularni rejasiga mos foydalanish mumkin.

Shakl Kkiritish. Shakllar, MS Word dasturida bajarish uchun "Insert" -> "Shapes"
funksiyasidan foydalanishingiz mumkin. Bu funksiya orgali, turli turdagi shakllarni, masalan,
kvadrat, aylana, triangel va boshqgalarini chizishingiz mumkin. Shu bilan birga, shaklga rang,
qalinlik, cho'zilishlar va qo'shimcha tahrirlar kiritishingiz mumkin.

Sxemalar kiritish. MS Word dasturida, "SmartArt" funksiyasi orqali turli turdagi sxemalar
qo'shishingiz mumkin, "SmartArt" funksiyasiga kirib, siz turli turdagi sxemalarni tanlay
olasiz, masalan, hierarxiya, sikl va boshgalar. Sxemalar, haqiqiy hayotda, ma'lum bir
konseptni tasvirlaydigan ko'p gator obyektlarni o'z ichiga oladi, va bu obyektlarni taxminan
har xil ranglarda ranglashingiz mumkin.

MS Word dasturi orqali, matndagi rasm, shakl va sxemalarni kiritish, tahrirlash va tuzish juda
oson. Buni qulaylik, tezlik va sodda bilan amalga oshirishingiz mumkin.

2. HTML da qu_;idagi ro‘yxatlarning har biri uchun kodni alohida yozing:
I. Telegram A Telegram

IT. WhatsappB. Whatsapp
I11. InstagramC. Instagram
I'V Imo D Imo
<html>

<head><title>4-bilet @ustoz</title></head> <body>
<font size=3>4-bilet<br><font color="blue"> <u>
<ul type=I>

<li>Telegram

<li>Whatsapp

<li>Instagram

<li>Imo</ul>

<br><font color="red"> <u>

<ul type=A>
<li>Telegram

<li>Whatsapp | BARGHA IMTIHON JAVOBLARINI
Sicme ™™ | T.ME/USTOZ TELEGRAM KANALI
b OROALI YUKLAB OLING!

</body>
</html>
3. 255(8), 6V(16) i 111010000(2) sonlarining o‘rta arifmetigini toping. Javebnio‘nlik
sanoq sistemasida ko‘rsating.

2555 = 2.8°+ 5.8 45.8% = 2.64 + 5:8 +5.1 =128+40+1=169,,

6Bic = 616" +B-16°=6-16+ 11-1=96+411=1071,

. . 1694107 .
o‘rta arifmetikka -- —138.-

Javob: 1381

5-BILET
1. MS Word dasturida hujjatlarda jadvallar bilan ishlash yo‘llari hagida ma’lumot
bering.
MS Word dasturi, hujjatlarda jadvallar bilan ishlash uchun qulay va tushunarli vositalarga ega.
Quyidagi yo'llar orqali, hujjatlarda jadvallar kiritish, ularga ma'lumot go'shish va ularga



formatlash mumkin:

Jadval kiritish: MS Word dasturida, menyudan "Insert” -> "Table" -> "Insert Table" orqali,
jadvallarni kiritish mumkin. Bu funksiyadan foydalanib, kerakli ko'rsatmalarni belgilashingiz
mumkin, masalan, jadval o'lchamlarini va gatnashuvchi yozuvlarni.

Jadvalni to'ldirish: Hujjatlarda jadvallarni ma'lumot bilan to'ldirish juda muhimdir. MS
Word dasturida, jadvaldagi har gqanday qutida yozish uchun, o'sha quting ustiga kirib, matn
yozishingiz mumkin.

Jadvalni formatlash: MS Word dasturida. jadvallarni qulay va tushunarli ko'rinishga keltirish
uchun bir gator funksiyalarga ega. Jadval elementlarining shirfti, galinligi, o'lchamlari va
ranglari kabi gismlarini o'zgartirish mumkin.

Jadvalni ajratish: Jadvalni bo'limlariga ajratish, hujjatlarni osonroq tushunarli va qulay
qgiladi. MS Word dasturida, jadvallarni ajratish uchun, menyudan "Layout" -> "Split Table"
orqali, jadvalni ajratishingiz mumkin.

Jadvalni birlashtirish: Jadval elementlarini birlashtirish, ularga ko'rsatmalar qo'shish va
ulardagi yozuvlarni bir-biriga moslashtirish mumkin. MS Word dasturida, jadval elementlarini
belgilab, menyudan "Layout" -> "Merge Cells" orqali, ulardan bitta jadvalli element yaratish
mumkin.

MS Word dasturi, hujjatlarda jadvallar bilan ishlash uchun qulay va tushunarli vositalarga ega.
Bu funksiyalar orqali, jadvallarni qulay va tushunarli ke'rinishga keltirish, ma'lumot bilan
to'ldirish va ularga ko'rsatmalar qo'shish mumkin.

2. 130 sonidan katta bo‘lmagan barcha toq sonlar yig‘indisini hisoblovchi dasturtuzing.
n=130

total = 0
foriin range(l, n, 2):

total +=i

print("Toq sonlar yig'indisi:", total)

3. 10011011(2) < x < 10011111(2) tengsizlikni ganoatlantiruvchi x ning nechtanatural
giymati mavjud? Javobda faqat sonlarning nechtaligini ko‘rsating. Sonlarning o‘zini
yozish shart emas.

10011011, = 1-27 + 1-2% +1-2° +1-2° +1-2° = 128+16+8+2+1 = 15555

10011111, = 1-27 + 1-20 +1-2° 4127 412 +1-2° =128+16+8+4+2+1= 159,

15,0 < x <155, BARCHA IMTIHON JAVOBLARINI
J_x.e 1;’.65157’158 T.ME/USTOZ TELEGRAM KANALI
sEhiLE ORQALI YUKLAB OLING!
6-BILET

1. MS Word dasturida WordART obyektidan foydalanish va formulalar Kiritishni
tushuntiring.

MS Word dasturi, matn va hujjatlar tayyorlash uchun bir qator qulay vositalarga ega. Bu
qulayliklar orasida, WordArt obyekti va formulalar kiritish imkoniyatlari mavjud.

WordArt obyektidan foydalanish. MS Word dasturida. menyudan "Insert”" -> "WordArt"
orqali, WordArt obyektini hujjatga go'shish mumkin. WordArt obyektini tanlagan vaqtda, siz
shakl, rang va yozuv shirftini tanlay olasiz. Bundan tashqari, siz obyekt ichidagi yozuvni ham
o'zgartirishingiz mumkin.

Formulalar kiritish. MS Word dasturi, formulalar Kiritish uchun "Equation" (tenglama)



nosozlikni qo'shgan. Menyudan "Insert" -> "Equation” -> "Insert New Equation" erqali,
formulalar kiritish imkoniyatiga ega bo'lishingiz mumkin. Shuningdek, siz WordArt
obyektlari kabi, formulalarni ham tahrir qilishingiz va ulardagi shirft, rang va usullarini
0'zgartirishingiz mumkin.

Formulalarni Kkiritish uchun, siz matn ustida misol uchun "Alt+=" tugmachasini bosing yoKki
"Design" ilovasidan kerakli formulani tanlash imkoniyatidan foydalaning. MS Word dasturi,
kiritilgan formulalarga qayta ko'rib, ularda tahrir qgilish va ulardagi usullarni o'zgartirish
imkoniyatiga ega.

Ko'p formulalar ko'rinishi kutilgan holatda "Ink to Math" ilovasini qo'shish orqali matn yozish
orqali yoki qalam orqali formulalar kiritish imkoniyatiga ega bo'lishingiz mumkin.

MS Word dasturi, WordArt obyektidan foydalanish va formulalar kiritish imkoniyatlari bilan
sizning hujjatlaringizga kreativlik keltirish imkonini ta'minlaydi.

2. Veb-sahifada quyidagi formulani chigaruvchi HTML kodni yozing:

<html>

<head> <title>6-bilet @ustoz</title></head>

<body>

<font size-6, color="blue ">

<hl>x<sup>3</sup>-y<sub>1</sub>*x<sup>2</sup>
+y<sub>2</sub>*x-y<sub>3</sub>=0</h1></font

</body>

</html>

3. 1243, 222, 1121, 245 sonlar yozilgan sanoq sistemasi eng kamida qanday asosga ega
bo‘lishi mumkin? Aniglangan asosdagi sanoq sistemasida ushbu sonlar yig‘indisini
hisoblang.

12436 + 2226 + 1121 + 2456 = 43154

Javob: 43156

7-BILET
1. Axborot nima? Axborotning ko‘rinishlari, xususiyatlari va turlari hagidatushuntiring.
Axborot ("Information" yoki "Info") - ma'lumotlarning jamlanmasidir, gaysi 0z ichiga o*zaro
bog‘liq elementlar tahrirlash, saqlash, o‘rganish, izlash va tarqatish imkoniyatlarini
ta’minlaydi. Axborot ma'lumotlarni saglash, tahrirlash va ko‘rsatishni oz ichiga oladi.
Axborotning ko‘rinishlari:
Matn (text) - yozuvlar, elektron xatlar va ma’ruzalar.
Audio - qulay eshitish uchun audio fayllar, podcastlar, radio dasturlari va boshqa yodgorliklar.
Video - ko‘rinishi va ijodkorligi uchun videolar, film va xabarlar.
Rasmlar (graphics) - o‘zaro bog‘liq elementlar, shakllar, diagrammalar va boshqa vizual
ma’lumotlar.
Animatsiyalar - yurgizilgan va yurgizilmagan rasmli va videodan iborat tarmoglar.
Axborotning xususiyatlari:
Qabul qilinuvchi shaxslar uchun yaratingan manbalar, maqgsadlari, vazifalari va ko‘rsatilish
usullari aniq bo‘lishi kerak.
Ma’lumot o‘z vaqti bilan yangilanishi va doimiy ravishda o*zgarishi mumkinligi. Bu tashki
manbalarda yangi ma’lumotlar e’lon qilinganida, shu bilan birga, saytlarda va ijtimoiy
tarmogqlarda ham ma’lumotlar yangilanishi mumbkin.
Tahrir qilinishi va tarqatilishi kerak. Shunday qilib, o‘zgarishlarga tayyor bo‘lish uchun,
ma’lumotlar xavfsiz saqlash uchun, yoki tushunilishi kerak bo‘lgan ma’lumotlarni to*liqrog



ko*rsatish uchun, o*zgartirilishiga muhtojlik bo‘lgan joylarda, tahrir gilish kerak.
Ma’lumotlar tarixi ham saqlanishi kerak. Bu, ma’lumotlar tarixini va tarixiy tahrirlash
imkoniyatini ta’minlash uchun keraklidir.

Axborotning turlari:

Asosiy axborot (Primary Information) - o‘zida direkt, maqsadli va yangilashga ihtiyotkor
axborotlarni 0°z ichiga oladi.

Yordamchi axborot (Secondary Information) - o*zida ko*plab manbalardan tuzilgan, yordam
beruvchi axborotlarni 0°z ichiga oladi.

2. “D:\image\” manzildagi “picture.png” rasmni veb-sahifaga chigaruvchi HTMLKodni
yozing. Bunda fon rangi sariq rangda va rasm markazda joylashsin.

<!DOCTYPE himl>
<html>

<head> o« BARCHA IMTIHON JAVOBLARINI
<title>Rasm ko ‘rsatish</title> T.ME /USTUZ TELEGR AM K AN AI.I

<style>

body | ORQALI YUKLAB OLING!

background-color: yellow;

/
img [
display: block;
margin: auto;
/
</style>
</head>
<body>
<img src="DNimage\picture.png">
</body>
</html>

3. Sonlarni tartiblang: a) o‘sib borish tartibida; b) kamayib borish tartibida:a) 74(8),
110010(2), 70(1(_)), 38(16); b) 6E(16), 142(8), 1101001(2), 100(10).
a) 74;= 78+ 48" = 56+4=60
110010, = 1-2° + 1.2 +1-2* =32+ 16 + 2 = 50y
70y = 704
38y = 316" + 816" = 4B + 8 = 56y
O'sish tavtibida:: S0, 56, 60, 70.
6) 6Ey =616 +E-16" = 6:16+ 14-1 = 96 +14 = 114,
142:= 1.8+ 48"+ 2-8° =64 + 32+ 2 =98,
1101001, = 1-2% + 1.2% + 1-2* + 1.29 = 64+32+8+1 = 105,
100, = 1004
Kamayish tavtibidaz. 114, 105,100,98

8-BILET
1. Axborotlarni kodlash va kodlash usullari hagida ma’lumot bering.
Axborotlarni kodlash - axborotni ma'lumetlar tizimida o‘rganish, qidirish va ishlatishni
osonlashtiradigan, kompyuter tomonidan tushuntiriladigan bir ko‘rsatkich sistema yaratishdir.
Bu, axborot tizimlaridagi ma’lumotlarni oson va tez topish, tahrirlash, qayta ishlash va
muvaffagiyatli muammo yechishni ta’minlaydi.
Axborotlarni kodlash usullari:



[. Markup tilidan foydalanish - Markup tilida ma’lumotlar ko‘rsatkichi sifatida xizmat giladi.
Markup tili, HTML, XML, XHTML kabi ma’lumotlarni kodlash uchun ishlatiladi. Markup
tili, qisqa va anigligi bilan ma’lumotlarni kodlashga yordam beradi, bu ma’lumotlar uchun
qayta ishlash va ko‘rishni ham osonlashtiradi.
2. Kuchli tilidan foydalanish - Kuchli tillar yordamida, masalan, Python, Java, C++, C# va
boshqalarida axborot tizimlarini yaratish mumkin. Kuchli tillar yordamida, axborot
tizimlaridagi ma’lumotlarni ajratib ko‘rish, qidirish, tahlil qilish, jadval va grafiklar yaratish,
ma’lumotlarni saqlash va hamda ma’lumotlarni o*zgartirish mumkin.
3. Statistik ta'lim algoritmlaridan foydalanish - Bu algoritmlar, ma’lumotlarni tahlil qilish,
qidirish va ma’lumotlardan natijalar olishda foydalaniladi. Bu usul, ma’lumotlarni tahlil qilish,
ishlab chiqish, tashkil etish va muammolarni yechishda yordam beradi.
4. Mashinalarning o‘qishini (Machine Learning) yoki Yagona Ne‘ron tarmog‘i (ANN)
yordamida axborotlarni kodlash - Mashinalarning o*qishini yoki Yagona Ne‘ron tarmog*ini
foydalanish, bir nechta xususiyatlar yoki ko*rsatkichlar asosida o‘rganilgan ma’lumotlarni tan
oladi va natijada, ma’lumot tahlilini o‘zining o‘ziga xos usuli bilan ishlaydi. Bu usul,
ma’lumotlarni qidirish, sinflandirish va tahlil qilishda yordam beradi.
2. Radiuslari 6em<R<16 cm ga teng bo‘lgan barcha doiralarning yuzini hisoblab,
natijalarni ekranga chigaruvchi dastur tuzing (R — natural sonlar).
import math
for rin range(6, 17):

area = math.pi * r**2

print(f"Radiusi {r} cm bo'lgan doira yuzi: {area:.2f} cm?®")
3. 128x128 piksel o‘lchamdagi rastrli tasvirni saqlash uchun 4 KB xotira ajratilgan.
Rasm palitrasida ranglarning mumkin bo‘lgan maksimal sonigancha?

Yechish:

V=4 KB BARCHA IMTIHON JAVOBLARINI
g 18 T.ME/USTOZ TELEGRAM KANALI

1i=

Formula: V = x *y *i ORQALI YUKLAB OLING!

128 * 128 = 16384 bit

4 KB =4 * 1042 = 4096 bayt = 4096 * 8 = 32768 bit
32768 : 16384 = 2 bit

Formula: N =2

N=2>=4

Javob: 4

9-BILET

1. Axborot va grafik axborotlarning kompyuterda tasvirlanishi haqida tushuntiring.
Axborot va grafik axborotlar kompyuterda tasvirlanishlari farkli usullarga asoslangan.
Axborot axborot tizimida matn shaklida saglanadi. Matnlar kompyuterda ikki xil shaklda
saqlanadi: kodlangan va kodlanmagan shaklda. Kodlangan matnlarni kompyuter ko‘rib
chigish mumkin, ammo kodlanmagan matnlarni chigarib berish uchun, matnni kodlangan
shaklda saglash kerak. Bunday matnlar, MS Word, Notepad, Sublime Text va boshqa muharrir
dasturlarda kodlangan shaklda yoziladi.

Grafik axborotlar esa ko‘p formatlarda saqlanadi. Ko*p xil formatlarda saqlanishi sababli,
foydalanuvchi o‘ziga kerakli formatni tanlashi mumkin. Bu formatlarga quyidagilari kiradi:
JPEG, GIF, BMP, PNG, TIFF kabi. Har bir formatning o‘ziga xos xususiyatlari mavjud.



Masalan, JPEG formati ranglarning ko*payishi bilan ajralib turadi, GIF formati esa ko‘rsatkich
va animatsiyalarni yaratishga imkon beradi.

Axborotlar va grafik axborotlar, ko‘rsatilish usullariga qarab tasvirlanadi. Axborotlar qatorlar,
ustunlar va ko‘rinishlarga asoslangan tashkil etiladi. Grafik axborotlar esa chizmalar, rangli
ko*rsatkichlar, diagraflar va boshqa turdagi axborot ko‘rsatkichlari yordamida tasvirlanadi.
Axborot tizimlarida tasvirlashning asosiy usullari kodlash va stil ko‘rsatkichlari, axborot
ko‘rsatkichlari va shakllaridan foydalanishdir. Grafik axborotlar esa, ilovalar yordamida
yaratiladi va ilovalar shu grafik axborotining xususiyatiga qarab tanlanadi.

Shu tarzda, axborot va grafik axborotlar kompyuterda turli shakllarda saqglanishi mumkin, va
ularni tasvirlashning bir nechta usullari mavjud.

2. Foydalanuvchidan beshta butun sonni so‘raydigan va shu sonlarning kvadratlarini
hisoblab ko‘rsatadigan dastur tuzing.

# Foydalanuvchidan beshta butun sonni so'raymiz

numl = int(input("1-sonni kiriting: "))

num2 = int(input("2-sonni kiriting: "))

num3 = int(input("3-sonni kiriting: "))

num4 = int(input("4-sonni kiriting: "))

num5 = int(input("5-sonni kiriting: "))

# Kvadratlarni hisoblaymiz
squarel = numl ** 2

square2 = rum2 =2 | BARCHA IMTIHON JAVOBLARINI
e e w3 | T.ME/USTOZ TELEGRAM KANALI
square = num5 ** 2 ORQALI YUKLAB OLING!

# Natijalarni chigaramiz

print("'1-sonning kvadrati:", squarel)

print("2-sonning kvadrati:", square2)

print("3-sonning kvadrati:", square3)

print("4-sonning kvadrati:", square4)

print("'5-sonning kvadrati:", square5)

3. 1024x768 piksel o‘lchamdagi va 65536 rangdagi palitrali monitorning grafikrejimini
amalga oshirish uchun zarur bo‘lgan kompyuter video xotirasining hajmini aniglang.
Formula: N = 2i

2i = 65536
2i =216
1=16

Formula: V=x*y *i

V'=1024 * 768 * 16 = 12582912 bit = 12582912 : 8 = 1572864 bayt = 1572864 : 1024 =
1536 Kbt

Javob: 1536 Kbt

10-BILET
1. Axborot texnologiyalari. Internet. Internetda ishlashni ta’minlovchi dasturlar
hagida ma’lumot bering.
Internet, bugungi kunda, global kompyuter tarmoqdir, va unda dunyoning bir gismi bilan



bog‘liq holda xizmat ko‘rsatiladi. Internet orqali foydalanuvchilar boshqa foydalanuvchilar
bilan xabar almashish, ma’lumot almashish, hujjat almashish, ijtimoily tarmoqda do®stlarni
izlash, savollar va javoblar gidirish, onlayn xarid qilish va boshga ko*plab amallarni bajarish
imkoniyatiga ega.

Internetda ishlashni ta’minlovchi dasturlar bir qancha mavjud. Bunday dasturlar
quyidagilarni 0z ichiga oladi:

Internet brauzerlari: Bunday dasturlar, foydalanuvchilarning internet saytlariga kirish va
ularga ko‘rishiga imkon beradi. Quyidagi brauzerlar mashhur: Google Chrome, Mozilla
Firefox, Microsoft Edge, Apple Safari kabi.

Elektron pochta dasturlari: Bu dasturlar elektron pochta xizmatlarini ta’'minlash uchun
ishlatiladi. Masalan, Gmail, Yahoo Mail, Outlook kabi.

2. Foydalanuvchidan ikkita son so‘raydigan va ularning yarim yig‘indisini ko‘rsatadigan
dastur yarating,.

# Foydalanuvchidan ikkita sonni kiritishni so'raymiz

numl = float(input("1-sonni kiriting: "))

num2 = float(input("2-sonni kiriting: "))

# Yarim yig'indini hisoblaymiz
half_sum = (numl + num2) /2

# Yarim yig'indisini chigaramiz
print("Ikkita sonning yarim yig'indisi:", half_sum)

3. Monitor 640x480 rejimida va 16 rangli palitrada ishlashi uchun 256 KBhajmdagi
videoxotira yetarlimi?

Fi'or'mula: N = 2! BARCHA IMTIHON JAVOBLARINI
e T.ME/USTOZ TELEGRAM KANALI
1=4 ORQALI YUKLAB OLING!

Formula: V=x*y*i
V =640 * 480 * 4 = 1228800 bit = 1228800 : 8 = 153600 bayt = 153600 : 1024 = 150 Kbt
Javob: Ha, yetarli

11-BILET

1. Axborot xavfsizligi tushunchasi va samaradorligi  ko‘rsatkichlari

hagidama’lumot bering.
Axborot xavfsizligi, shaxsiy ma'lumotlar va biznes ma'lumotlarini 0‘z ichiga olgan barcha
tizimlar uchun juda muhimdir. Axborot xavfsizligi, bizning shaxsiy va korporativ
ma'lumotlarimizni muhofaza qilish, hujjatlarimizni, tarmoglarimizni va kompyuterlarimizni
hakerlar, vayronalar, viruslar va boshqa xavfsizlik xavfsizlik rivojlari garshi himoya qilishni
0‘z ichiga oladi.
Axborot xavfsizligi ko‘rsatkichlari quyidagilardir:
Authentication (tasdiglash): Bu ko‘'rsatma, foydalanuvchilarni va ularing to‘g'n
tasdiglanganligini aniglash uchun ishlatiladi. Masalan, foydalanuvchining paroli va
foydalanuvchi nomi tasdiglash.
Authorization (huquq berish): Bu ko‘rsatma, foydalanuvchilar tomonidan kiritilgan hujjatlar
va ma'lumotlarga kirishni huquq berish yoki qora ro‘yhatdan o°tishni belgilashni o°z ichiga



oladi.

Encryption (shifrlash): Bu ko‘rsatma, hujjatlar va. ma'lumotlarni shifrlash va xavfsizlashtirish
jarayonini bildiradi, shuningdek, shifrlash va xavfsizlashtirishning usullari.

Firewall (xavfsizlik devori): Bu ko‘rsatma, tarmoq trafikini boshgarish va kontrol qilishni,
hakerlar va vayronalarga qarshi himoya qilishni 0°z ichiga oladi.

Antivirus (viruslar to‘plamiga qarshi dastur): Bu ko‘rsatma, viruslar va boshqa hujumlar qarshi
himoya qilish uchun xavfsizlik dasturini ta’minlashni bildiradi.

Backup (rezerv kopya): Bu ko‘rsatma, hujjatlar va ma'lumotlarni o°z ichiga olishning usullari,
har qanday sababga ko‘ra ma'lumot yo‘qotilganda ma'lumotlarni qayta tiklashga yordam
beradi.

Axborot xavfsizligi samaradorligi, hujjatlar va ma'lumotlarni xavfsizligi ta’minlashga yordam
beradi va shaxsiy va korporativ ma'lumotlarimizning himoyalanganligini ta’minlashga
yordam beradi.

2. Tekislikdagi A(x1, y1) va B(xz, y2) nuqtalar orasidagi masofani hisoblovchidastur

tuzing:

e BARCHA IMTIHON JAVOBLARINI
program B_11; T.ME/USTOZ TELEGRAM KANALI
ol ORQALI YUKLAB OLING!

Var x,y,x1,yl,ab:rezl;

Begin

Write('vvedite koordinati 1 tochki cherez probel: °); readin(x,y);

Write('vvedite koordinati 2 tochki cherez probel: ');

readin(x1,y1);

ab:=sqrt(sqr(x1-x)+sqriyl-y));

writeln(‘paccrosnHme mexay To%amm| pasHo:',ab:0:1);
writeln('koHel nporpammnl ');

end.

3. Monitor 640X400 piksel rejimida 16 ta rang palitra bilan ishlaydi. Rasmni kodlash
uchun 1250 Kbayt zarur. Buning uchun gancha videoxotira kerak bo‘ladi?
Formula: N = 2

25516
2i:24
=4

Formula: V=x*y*i

V=640 * 400 * 4 = 1024000 bit = 1024000 : 8 = 128000 bit = 128000 : 1024 = 125 Kbt
1250: 125 =10

Javob: 10 ta video xotira kerak

12-BILET
1. Axborotlarni himoyalashning tarkibiy gismlari va usullari. Kriptologiya tushunchasi
hagida tushuntiring.
Axolotllarni himoyalashning tarkibiy gismlari va usullari:
1. Shifrlash - Ma'lumotlarni shifrlash, ularni boshqa kishilar uchun noaniq va odob-axloq
bo'lmaydi. Bu bir necha usullar orqali bajarilishi mumkin, masalan, simmetrik va asimmetrik
shifrlash algoritmalari.



2. Axborotni yashirish - Ma'lumetlarni himoyalash uchun ularni yashirish, yani o'zgarisiz
ko'rish mumkin bo'lmagan holatga o'tkazish lozim. Bu ko'rsatmalarning yashirin holda
saqlanishi, internet trafikini himoyalash, shaxsiy ma'lumotlarni himoya qilish va boshqa
ko'rsatmalarni himoyalash uchun muhimdir.

3. Kimni tasdiglash - Ma'lumotlar boshga insonlarga yetkazilganda, ularning to'g'ri va
himoyalanganligini aniglash uchun kimning tasdiglanishi kerak bo'ladi. Buning uchun imzo,
autentifikatsiya protokellari, biometrik ma'lumotlarni tasdiglash usullari, man-to-man
tasdiglash va boshga usullar ishlatiladi.

Kriptologiva tushunchasi:

Kriptologiya - himoya (shifrlash) va kuzatish (de-shifrlash) texnologiyalari va ilmiy fan.
Kriptologiya ma'lumotlar to'plamini himoyalash uchun matematik metodlaridan toydalanadi.
Bu fan odatda shifrlash algoritmalari va protokollari, autentifikatsiya protokollari, imzo va
autentifikatsiya tizimlarini, va hokazo, qurilish va to'g'ri ishlashini ko'rsatadi. Kriptologiya
matematik, informatika, shifrlash nazariyasi, va boshqa sohalarning tarmoqlarini 0'z ichiga
oladi va sifatida, o'zining ko'p yo'nalishlari mavjud.

2. Fazoda A(Xa, Vas Za) va B(xs, ¥, Zv) nuqtalar orasidagi masofani hisoblovchidasturni
tuzing:

AB = V(x— x:)2 + (Yo— Ya)? + (2o— 2Za)?

program B_12;

Uses crt; BARCHA IMTIHON JAVOBLARINI

Var x,y,x1,y1,z,z1,ab:real;

Begin T.ME/USTOZ TELEGRAM KANALI

Write('vvedite koordinati 1 tochki cherez probel: ');

readinxy,z); ORQALI YUKLAB OLING!

Write('vvedite koordinati 2 toechki cherez probel: ');

readin(x1,y1,21);
ab:=sqri(sqr{x1-x)+sqrlyl-y)+sqr{zl-z));
writeln(‘paccToatmne memay To4Kamn pasHo: ',abi0:1);
writeln('xoHel nporpammst ');

end.

3. Kompyuterning videoxotirasi hajmi 512 KB ni tashkil gilishi ma’lum. Ekranning
o‘lchamlari 640X200 piksel. 8 ta rang palitra bilan bir vaqtningo‘zida videoxotiraga
nechta ekran sahifasi sig‘ishi mumkin?

Formula: N = 2!

2! 2R 2
I'=3

Formula: V=x*y *i

V = 640%200%*3 = 384000 bit 384000 : 8 = 48000 bayt = 48000 : 1024 = 46,875 Kbt = 47 Kbt
512:47=10,89 = 11

Javob: 11 sahifa

23

13-BILET
1. O‘zbekistonda elektron hukumat, uning asosiy vazifalari va faoliyat yo‘nalishlari
haqida ma’lumet bering.
O‘zbekistonda "Elektron hukumat" deb nomlangan tizim, davlat va jamiyat tashkilotlarining
barcha hujjatlari, ma’lumotlari, xizmatlari va biznes faoliyati uchun keng imkoniyatlar
yaratuvchi, internet orqgali alogani o‘rganuvchi va o‘zlashtiruvchi, xalgaro standartlarga



muvofiq va isloh qilinishi davlat dasturiga asoslangan axborot-kommunikatsiya
texnologiyalari tizimi hisoblanadi.

Elektron hukumatning asosiy vazifalari quyidagilar hisoblanadi:

1. Barcha tashkilotlar va hududlar orasidagi tarmoglarni integratsiyalash va ularning
faoliyatini samaraliroq va tezroq gilish;

2. Xizmatlar va hujjatlar tagsimlanish va ularni tagdim etish jarayonlarini avtomatlashtirish;
3. Davlat boshqaruvi tizimini boshqarish va ta’minlash;

4. Respublikaning ma’muriy-hududiy boshqaruvi sohasida samarali xizmat ko‘rsatish;

5. Davlat boshqaruvi organlarining yuritish jarayonini uzluksiz, tez va sifatli amalga oshirish.

Elektron hukumatning faolivat yo ‘nalishlari quyidagilardan iborat:

1. Axborot-kommunikatsiya texnologiyalari sohasida integratsiya va isloh qilish;

2. Tizimni qo‘llab-quvvatlash va rivojlantirish;

3. Elektron hukumatning tizimining ishlab chiqarilishi, qo*llab-quvvatlanishi va ta’minoti;
4. Elektron hukumatning tizimini o‘zlashtirish:

5. Elektron hukumatning xizmatlarini taqdim etish va ularga yordam berish.

6. Elektron moliyaviy xizmatlar tashkil qilish, yuritish va o*zlashtirish;

7. Elektron hukumatning xizmatlariga alogada tashkilotlar va shaxslarga xizmat ko‘rsatishni
ta’minlash.

Bular elektron hukumatning asosiy yo‘nalishlari hisoblanadi.

2. Quyidagi ifoda giymatini hisoblovchi dasturni tuzing:

X6y

ey BARCHA IMTIHON JAVOBLARINI
program 8_13; | T ME/USTOZ TELEGRAM KANALI

Uses crt;

Var x,y,d:real; URUAL' YUKLAB 0L|NG|

Begin

Write('vvedite x: '); readin(x);

Write('vvedite y: '); readin(y);

d:=((2*sqr(x)-6*y)/(x+y)*(x-y))/(24/9%sqr(x)-

9*sqrly))+sart{4=exp(8*in(x)));

writeln('d=",d:0:1);

writein('koxey nporpammel ');

3. A va V o*zgaruvchilar juftligi uchun quyidagi tenglik rost bo‘ladigan jamigiymatlar
sonini toping: F=(AvB)&(—Av—B)=YOLG*ON.

A B —A |-B|AvB |“Av—B | (AvB)&(—Av—B)
0 0 1 1 0 1 0
0 | 1 0 1 1 1
1 0 0 1 1 1 1
1 1 0 0 1 0 0

Javob: 2



14-BILET
1. Kompyuter grafikasi guruhlari va turlari. Photoshop rastrli grafik muharriri va uning
interfeysi hagida tushuntiring.
Kompyuter grafikasi guruhlari quyidagilardan iborat:
I. Vektor grafika: Bu tur grafikalar ma'lumotlarni geometrik ob'ektlar (to'g'ri chizg'ichlar,
aylanalar, shaxslar va boshgalar) yordamida ifodalashga imkon beradi. Bu tur grafikalar
ko'proq to'g'ri chizg'ichlar, logo va yozuvli ma'lumotlarni yaratish uchun foydalaniladi.
2. Rastrli grafika: Bu tur grafikalar qattiq anigligi bo'lgan tasvirlardan iborat bo'lib, chizilgan
obrazlarni to'playdi. Bu tur grafikalar rasmli fayllar, rasmlar, suratlari va boshgalar kabi
ma'lumotlarni yaratish uchun foydalaniladi.
3. 3D grafika: Bu tur grafikalar tizim va tasvirli ob'ektlarning uch xil koordinatalarini o'z ichiga
oladi: uzunlik, kenglik va balandlik. Bu tur grafikalar kompyuter o'yinlarida, animatsiyalarda
va arxitektura sohasida foydalaniladi.
Photoshop rastrli grafik muharriri Adobe tomonidan yaratilgan tajribali dastur hisoblanadi.
Uning asosiy vazifasi, foydalanuvchilarga yuqori sifatli rasm va suratlar yaratish, tahrirlash va
tayyorlashtirish imkoniyatini taqdim etishdir. Adobe Photoshop muharriri yozuv, rasmlar va
shakllarni moslashtirish, qayta ishlanish va jamlash yoki tahrirlash uchun bir qator vositalarni
0'z ichiga oladi.
Photoshop interfeysi esa ko'pgina tasyir muharrirlarining standart interfeysiga o'xshash
ko'rinishda bo'lib, asosiy menyu va panel oynalari o'rtasida joylashgan. Bu interfeys yaxshi
tuzilgan bo'lib, foydalanuvchilar Photoshopni yaxshi ko'rib chigishadi va ularni rasm va
suratlarni tahrirlashga yo'l qo'yishga o'rgatadi.
2. 20 ta elementli massivni 1000 gacha bo‘lgan tasodifiy sonlar bilan to‘ldiradiganva
ekranga ularning ichidan faqat ikki xonali sonlarni chigaradigan dasturni tuzing.
import random
# Tasodifiy sonlar massivini to'ldiramiz

e B BARCHA IMTIHON JAVOBLARINI
nums.append(random.randint( 1, 1000)) T.ME / USTOZ TELEGRAM KANALI
# Fagat ikki xonali sonlarni chigaramiz ORQAL! YUKLAB OLING!

for num in nums:
if num >= 10 and num <= 99:
print(num)
3. A va V o‘zgaruvchilar juftligi uchun quyidagi tenglik rost bo‘ladigan jamigiymatlar
sonini toping: F=(AvB)&(~A&~B)=ROST.

o~ B -A |“B|AVB |=A v —-B | (AvB)&(—Av—B)
0 0 1 1 0 1 0
0 1 1 0 1 1 1 i
1 0 0 1 1 1 1
1 1 0 0 1 0 0
Javob: 2
15-BILET

1. Photoshop uskunalar paneli va palitralari haqida ma’lumot bering.



Photoshop uskunalar paneli va palitralari, Adobe Photoshop dasturining asosiy gismlaridan
biri hisoblanadi va rasm tahrir qilish jarayonida o'zgaruvchilarni moslashtirish va
o'zgartirishga imkon beradi. Ularning ba'zilari quyidagilar kabi:

1. Layerlar paneli: Bu panel yordamida foydalanuvchi har bir elementni alohida qavatlar
(layerlar) shaklida yaratishi mumkin, bu esa foydalanuvchiga rasmning har bir gismiga alohida
yondashishga imkon beradi.

2. Brush paneli: Bu panel yordamida foydalanuvchi uchun turli chizim usullaridan birini
tanlash mumkin. Shu bilan birga, foydalanuvchi farkli o'lchamdagi pensillar yoki chizgichlar
bilan ishlashga imkon beradi.

3. Swatches palitras: Bu palitra, foydalanuvchiga turli ranglar va rang kombinatsiyalaridan
tashkil topgan bo'lib, ularni rasm tahrir gilishda ishlatishga imkon beradi. Foydalanuvchi shu
yerda mavjud bo'lgan ranglar orasidan tanlov qiladi va ularni ishlatishga boshlaydi.

4. Tool paneli: Bu panel, Photoshop dasturining asosiy uskunalaridan birini ifodalaydi. Bu
panel yordamida foydalanuvchi rasm tahrir gilish jarayonida qo'llanadigan turli uskunalar
bilan tanishadi.

5. Navigator paneli: Bu panel yordamida, katta yoki kichik rasmni ko'rishga imkon beradi va
foydalanuvchi rasmning ma'lum bir gismini olib ke'rish uchun foydalanadi.

6. History paneli: Bu panel yordamida foydalanuvchi o'zgarishlarni qayta ko'rish vaqti keldi.
Shu bilan birga, foydalanuvchi bir necha amallarni (misel: moslashtirishlar, saqlashlar va
boshqalar) qayta bajarish imkoniyatiga ega bo'ladi.

Bu uskunalar paneli va palitralari, Photoshop dasturining yordamida ishlaydigan har bir
foydalanuvchi uchun zarur bo'lib, ularning yordamida rasm tahrir qilish jarayoni ko'proq
samarali va sodda bo'ladi.

2. Quyidagi HTML kodining natijasini aniglang:

<IDOCTYPE html>

<html> <head> <title>Bayram</title> </head>

<body> <h2 align=""right’> <i> Assalom </i> </h2>

<palign="center”> <h1> <u> Navro‘z! </u> </h1> </p> </body>

</html>
BARCHA IMTIHON JAVOBLARINI

T.ME/USTOZ TELEGRAM KANALI

Navro‘z! ORQALI YUKLAB OLING!

3. Quyidagi mulohaza uchun rostlik jadvalini tuzing: — (A A—VV—A),

Assalom

A 8 [-A [-B]AA-B [AA-BV-A [-(AN-BV-3)
o |lo [1 1 |o 1 |0
0 |1 1 0 |1 1 0
1 |0 0 1 |0 0 1
1 |1 0 0 |0 0 1
16-BILET

1. Photoshop fayllari bilan ishlashni tushuntiring.
Photoshop dasturi bilan fayllar bilan ishlash quyidagi bosgichlardan iborat:
1. Rasm faylini ochish: Photoshop dasturini oching va "File" menyusidan "Open" ni tanlang.



Keyin rasm faylini tanlang va ochish tugmasini bosing.

2. Faylni saglash: Tahrir gilingan faylni saglash uchun, "File" menyusidan "Save" ni tanlang
yoki "Save As" ni tanlang va fayl nomini va saqlash joyini tanlang.

3. Faylni eksport qilish: Faylni boshqga formatga eksport gilish uchun, "File" menyusidan
"Export” ni tanlang va foydalanish kerak bo'lgan formatni tanlang.

4. Rasm o'lchamini o'zgartirish: Faylni oching va "Image" menyusidan "Image Size" ni
tanlang. Keyin, yangi o'lchamni kiritib, o'lchamni o'zgartiring.

5. Moslashitirish: Faylni oching va moslashtirishni tanlang. Tashqi Moslashitirish usuli
tanlandiqdan so'ng. foydalanuvchi o'zgartirishni bajargan holda birinchi imkoniyatda faylni
saglashni ham tanlay oladi.

6. Ranglar bilan ishlash: Faylni oching va "Image" menyusidan "Adjustments" ni tanlang.
Keyin, yangi ranglar yoki tonlar qo'shish uchun kerakli moslashtirishni tanlang.

7. Layerlar bilan ishlash: Faylni oching va "Window" menyusidan "Layers" ni tanlang. Keyin,
yangi qavatlar yaratish, ularni yo'q qilish yoki moslashtirish uchun moslashtirishlarni amalga
oshirishingiz mumkin.

Bu yordamda Photoshop fayllari bilan ishlash, rasm tahrir gilish uchun zarur bo'lgan asosiy
vazifalarni o'z ichiga oladi va foydalanuvchiga rasmning har bir gismiga alohida ravishda
kirish va uni tahrir gilish imkoniyatini beradi.

2. HTML da quyidagi jadvalni chigaruvchi kodni yozing:

l @ (lpumep #a saroncsxy Tabaauer X

& ol s | BARCHA IMTIHON JAVOBLARINI
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Aspopon 0vd____|8000 ORQALI YUKLAB OLING!

|ASayranmapos Asmokos|| 7000 ]
<table>
<tr>
<th><b=>Ismlar</b></th>
<th<b>>3apniama</b></th>
</tr>
<fr>
<td>Ab6popos I0cygh</td>
<td>8000</td>
</tr>
<tr>
<td>Aooyeannapoe Azumdnwon</td>
<td>7000</td>
</tr>
</table>
3. Quyidagi mulohazalarning teng kuchli ekanini isbotlang:
AVBAC:2)(AVV)A(AVS).
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1. “PhotoShop”da tasvirning gismini ajratib olishni tushuntirib bering.

"Photoshop"da tasvirning gismini ajratib olish uchun "Crop Tool" yoki "Marquee Tool"dan
foydalanishingiz mumkin.

1. "Crop Tool" bilan ajratib olish:

e "Crop Tool"ni tanlang (klavishalarni bosing: C)

e Rasmning ustiga kirib, tasvirlashni istagan joydan boshlang. Yuqoridagi konteynerlarni
o'zgartirib, so'ng "Enter" tugmasini bosing yoki mouse tugmasini bosing va chizigni
tasdiglang.

2. "Marquee Tool" bilan ajratib olish:

e "Marquee Tool"ni tanlang (klavishalarni bosing: M).

e Tasvirlashni istagan joydan boshlab, tasvirning ajratishni istagan gismini ajratib olasiz.

e Ajratilgan gismni "Ctr]" (Windows) yoki "Cmd" (Mac) + "X" tugmalarini bosing va
olish joyida "Ctrl" (Windows) yoki "Cmd" (Mac) + "V" tugmalarini bosing.

Bunday usullar orgali, tasvirning qismini ajratib olishning bir nechta turini amalga
oshirishingiz mumkin.

2. a, b, ¢ “uchta” kesmaning uzunligi berilgan. Ushbu kesmalardan uchburchak hosil
qilish imkoniyati mavjud bo‘lsa, uchburchakning yuzi va perimetrini hisoblash dasturini
tuzing.
import math

o BARCHA IMTIHON JAVOBLARINI
e e T.ME/USTOZ TELEGRAM KANALI
¢ = float(input("c ni kiriting: ")) UR[I AL' YUKLAB UI.ING'

# Uchburchakning yuzini hisoblaymiz
s=(a+b+c)/2
area = math.sqrt(s *(s - a) *(s-'b) *(s-c))

# Uchburchakning perimetrini hisoblaymiz
perimeter =a + b+ ¢



print("Uchburchak yuzi: ", area)

print("Uchburchak perimetri: ", perimeter)

J.Agar A =1,B=1,8=0,D =0 bo‘lsa, quyidagi mantiqiy ifodalarning gqiymatinitoping:
a) A OR BAND NOT S.

b) AAND NOT B OR S.

¢) AOR B AND NOT (S AND D).

d) (A AND B) ORNOT S AND (A OR B) OR NOT D.
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1. “PhotoShop”da tasvirlarni kadrlash hagida ma’lumot bering.
"Crop Tool"ni oching: "Crop Tool"ni oching yoki klaviyaturada "C" tugmasini bosing.
Tasvirlashni istagan gismini belgilang: Tasvirlashni istagan gismini belgilashingiz uchun
"Crop Tool" bilan tasvirning ustiga kirib, chizigni tasdiglashingiz kerak. Tasvirni kadrlangan
qismini har tomonini o'lchash uchun o'lchamlarni boshqarish knopkalaridan foydalanishingiz
mumkin.
Tasvirning orqasidan ko'z yoshi qo'shish: Tasvirlashdan oldin tasvirning orgasidan ko'z yoshi
go'shishingiz kerak bo'lgan holatlar mavjud bo'lishi mumkin. Buning uchun "Canvas Size"
yoki "Image Size" funksiyalaridan foydalanishingiz mumkin. Tasvirlashning boshqa
gismlarini ko'rsatishni xohlasangiz, tasvirning o'lchamini o'zgartirib, "Free Transform"ni
tanlang va tasvirni kerakli o'lchamda joylashtirish uchun chizigni tasdiglang.
Tasvirlarni  kadrlashda yorliglarni =~ foydalanish: ~ Tasvirni  kadrlashda  yorliglarni
foydalanishingiz mumkin, bu esa tasvirning foydalanishga tayyorlash uchun katta ahamiyatga
ega bo'ladi. "View" menyusidan "Show" ni tanlang va "Grid" va "Guides" ni belgilang.
Qadamgaqa o'lchamlarni o'rnatish uchun ko'rsatilgan joyni bosing va mouse orgali ko'rsatilgan
joydan chizigni ko'paytiring. Chizigni yo'q qilish uchun, ko'rsatilgan joydan chizigni torting
va yukoridagi menyudan "View"ni tanlang, keyin "Clear Guides"ni tanlang.
2. 8-00 dan 20-00 gacha har soatda havo harorati o‘lchanadi. Bu vaqt ichida haroratning
oshishi kuzatiladi. Kuzatishda ro‘y beradigan birinchi musbat havo harorati vaqtini
aniqlaydigan dastur tuzing.
start_time =8 * 60 # Soatlar minutga aylangan sana
end_time = 20 * 60

(Gt e # osianichvagt | BARCHA IMTIHON JAVOBLARIN
temperature = 0 # Boshlang 'ich harorat T.ME / USTOZ TELEGRAM KANALI
while t <= end_time: DROALI YUKLAB 0L|NG|

temperature += 1 # Haroratni oshiramiz
if temperature > 0: # Harorat musbat bo'lsa
print(f"Musbat havo harorati kuzatilgan vagt: {t // 60}:{t % 60:02}")
break # Musbat harorat topilgan, tsikldan chigamiz
t += increment # Vagqtni oshiramiz
3. Ifodalardagi mantiqiy amallarni bajaring va giymatini toping.




D<A I=3v2I<S 2)1>3vI<2:

2<5:2) 123 v 1<2: 3) 1<3 v $=7.
I=3v2<5=]

I=3

Yolg on

2 < 5=Rosl

Shunday qilib, bizda:
lAGv]i=0vIi=|

Javob: Rost
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1. “PhotoShop”da shakl almashtirish amallarini tushuntiring.
|. Shaklni belgilang: Shakl almashtirishdan oldin, o'zgartirishni xohlagan shaklIni belgilang.
Buning uchun "Move Tool" ni tanlang (klavishalarni bosing: V), shakIni tanlang va o'zgartirish
uchun tayyor bo'ling.
2. Shaklni almashtirish: Shaklni almashtirish uchun, "Edit" menyusidan "Transform"ni tanlang
va kerakli almashtirish ko'rinishini tanlang. Almashtirish ko'rinishlari:

v Scale (o'lchamni o'zgartirish)

v" Rotate (aylanish)

v" Skew (kesishma)

v" Distort (bo'yoqqa o'tkazish)

v Perspective (biror bir nuqtadagi tashgi nuqta hujjatini tekshirish)
3, Shaklni boshqga shaklga o'tkazish: Shaklni boshga shaklga o'tkazish uchun "Edit"
menyusidan "Transform"ni tanlang va "Warp"ni tanlang. Bu funksiya yordamida shaklning
gavsida tasvirlar yaratishingiz, shaklga go'shimcha mohiyat qo'shishingiz va boshga
o'zgarishlar kiritishingiz mumkin.
4. Shaklni bir nechta almashtirishlar bilan birlashtirish: Agar siz bir nechta shaklni
birlashtirishni xohlasangiz, ulami bitta gatorda joylashtirib, kerakli almashtirishni belgilab,
"Edit" menyusidan "Auto-Align Layers"ni tanlash va "Edit" menyusidan "Auto-Blend
Layers"ni tanlab, harakat gilishingiz mumkin.
5. O'zgartirishlarni tasdiglash: Shu oxirgi qadamda, o'zgartirishlarni tasdiglash uchun "Enter"
tugmasini bosish yoki "Commit Transform" (Transformni tasdiglash) tugmasini bosishingiz
kerak.
2, 10 ta familiyadan iborat massiv berilgan. Klaviaturadan Kiritilgan harfdan
boshlanuvchi familiyani ko‘rsatadigan dastur tuzing.
families = ['Abdullaev', 'Abdurakhmonov’, 'Alimov’, 'Azizov', 'Ergashev’,

‘Ibragimov’, 'Ismoilov’, 'Karimov', 'Muminov', 'Kenjaev']

start_letter = input("Familivalar gaysi harf bilan boshlanishi kerak? ")
found = False # Boshlanuvchi harf topilganimi

for family in families:

7 fumily.siarswith star_lre BARCHA IMTIHON JAVOBLARINI
iy T.ME/USTOZ TELEGRAM KANALI
ORQALI YUKLAB OLING!




if not found:
print(f'{start_letter} harfi bilan boshlanadigan hech qanday familiya topilmadi.")
3. MS Excel. Quyidagi formula natijasini aniglang: =YESLI(STEPEN(8;3)<100;
SSEPIT(*O*zbekiston™; “— mening Vatanim™); SUMM(111;172)).
2,283
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1. “PhotoShop”da gatlamlar va ulardan foydalanish hagida ma’lumot bering.
"Photoshop'da gatlam ("Layer") - bu tasvirning turli elementlarini alohida gatlamga joylash
uchun ishlatiladigan qurilmadir. Qatlamlar, tasvirdagi har qanday obyektlar, matn, yorug'liklar
va boshqga narsalar 0'z ichiga oladi va ulami alohida tartibda boshqga tasvirlar ustiga joylash,
tahrirlash va boshqa amallar uchun foydalaniladi.
Qatlam yaratish uchun, "Layer" bosgichidan "New Layer'ni tanlang va keyingi dialog
oynasida gatlam nomini, xususiyatlarni va ko'rsatkichlarni belgilang. Qatlamlarni birlashtirish,
ko'chirish, o'chirish, ko'paytirish va boshga o'zgarishlar uchun, "Layers" panelidan yoki
klaviatura yordamida foydalanishingiz mumkin.
Qatlamlar, bir nechta imkoniyatlar yaratish uchun foydalanishga qulaydir, misol uchun:

v" Obyektlarni alohida qatlamga joylash va har qanday o'zgarishlarni ajratib turish;

v Qatlamni ko'chirib turish, uni yuqoriga yoki pastga o'tkazish;

v" Qatlamlar ustiga reng ko'rinishlaridan, qoplamalar va effektlardan foydalanish;

v" Qatlamlarni o'chirish yoki yopish orqali, tasvirda ishlatilmagan obyektlarni olib

tashlash;
v" Qatlamni bir qatordan boshgaga ko'chirish orqali, turli tasvir elementlarini yarating;
v/ Har ganday qatlamlarni bloklangan yoki tanlangan holatlarda tekshirish uchun alohida
joylashishi mumkin.

"Photoshop”da qatlamlardan foydalanish, tasvirlarni tahrir gilishni osonlashtiradi va foydali
bo'lishiga imkon beradi. Qatlamning har bir xususiyatidan foydalanish bilan, tasvirni tahrir
qilish va boshqa xizmatlar uchun qulay va samarali usul yaratishingiz mumkin.
2. Klaviaturadan kiritilgan ixtiyoriy natural senning tub yoki murakkab son ekanini
aniglovchi dastur tuzing.
def prime_check(n):

o=l BARCHA IMTIHON JAVOBLARINI
elifn == 2 T.ME/USTOZ TELEGRAM KANALI

return True
else: ORQALI YUKLAB OLING!
for i in range(2, int(n**0.5) + 1):
ifn%i==0:
return False
return True

num = int(input("Ixtiyoriy natural son kiriting: "))
if prime_check(num):
print("Bu son tub son hisoblanadi.")
else:
print("Bu son murakkab son hisoblanadi.")
3. MS Excel. Agar A1=1024, V1=4 va V2=2 bo‘lsa, guyidagi formula natijasinianiqlang:



=STEPEN(A1;V2)+MAKS(A1:V2)-SRZNACH(A1:V2).
=CTEINEHB(AL:B2)-MAKC(AL:B2)-CP3HAM(AL:B2).

CTEMEHL(A:B2)=1048576:

AKC(ALB2= 102 BARCHA IMTIHON JAVOBLARINI
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Javob: 104925634 ORQALI YUKLAB OLING!
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1. “PhotoShop”da RGB ranglar tizimi hagida tushuntiring.
"Photoshop"da RGB ranglar tizimi, tasvir yaratish va tahrir gilishda juda muhimdir. RGB
ranglar tizimi, tasvirlarni yaratishda, tahrir gilishda va ekranda ko'rishda foydalaniladigan
tizim hisoblanadi.
RGB tizimida ranglar qizil (R), yashil (G) va ko'k (B) ranglari kombinatsiyasidan yaratiladi.
Bu ranglar intensivliklarini 0 dan 255 gacha bo'lgan sonlar orqali ifodalashadi. Masalan, g'isht
rangi, qizil va yashil ranglarining yorug'ligi va intensivligi kombinatsiyasidan yaratiladi.
Yorug'lik tizimi intensivlikni O ga teng, yorug'likdan uzog'ini esa 255 ga teng ifodalaydi.
"Photoshop"da tasvirlarni tahrir qilish uchun, tagriban har bir funksiyada ranglar bilan
ishlovchi bo'lishingiz kerak bo'ladi. Masalan, tasvirni yaratishda, ranglar tizimi tasvirdagi har
bir elementning yorug'ligini, intensivligini va yo'nalishini aniglash uchun kerak bo'ladi.
Shuningdek, tasvirlarni ko'rishda, ranglar tizimi tasvirning ko'rinishini, yorug'lik darajasini va
intensivligini aniglashga yordam beradi.
"Photoshop"da tasvirni yaratishda, ranglar tizimini o'zgartirish mumkin. Masalan, RGB
tizimidan CMYK tizimiga o'tkazish mumkin. CMYK tizimi, tasvirlarni chapa olishda
foydalaniladigan tizim hisoblanadi. CMYK ranglar tizimida ranglar qalam, magenta, sariq va
gora ranglari kombinatsiyasidan yaratiladi. Bu tizimida har bir rang intensivligini 0 dan 100
gacha bo'lgan foizlar orgali ifodalaydi.
Ranglar tizimi tasvirlarni tahrir qilishda juda muhimdir, shuning uchun siz tasvirlarni tahrir
gilishda va yaratishda, RGB tizimini yaxshi tushunish kerak.
> yuzini hisoblovchi dastur tuzing:

length = float(input( "Sohaning uzunligi: "))
width = float(input("Sohaning eni: "))

area = length * width

print(f"Sohaning yuzasi: {area]")

3. MS Excel, Al=1, S1=A1+5, A2=A1+V2,V2=MIN(A1:S1), S2=V2*V1 berilgan.
A2 yacheyka tegishli gistogramma uvzunligi B2 va C2 yacheykalarga tegishli
gistogrammaning har bir gismidan ikki barobar uzunroq. Bundan kelib chiqqan holda
quyidagi formula giymatini hisoblang:

=YESLI(KOREN(A1)>A2-Al: SRZNACH(A1;V2); SRZNACH(A1;S2)).
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[. “PhotoShop”da CMYK ranglar modeli hagida ma’lumot bering.

2. “O‘zbekiston — mening Vatanim™ jumlasini veb-sahifaning o‘rtasida yashil rangda,
tagchizigli ko‘rinishda 2-marta chigaruvchi HTML Kkodni yozing.

<html>

<head>stitle>1-bilet @ustoz</title></head>

<body>

<font size=5>1 - bilet

<br>

<p align=center><hl><font color="green"> <u>Q 'zbekiston — mening Vatanim

<br>0 ‘zbekiston — mening Vatanim

</u></font></p>

</body>

</html>

3. Elektron jadvalning bir qismi berilgan. Formula D2 katakchadan El1 va E3
katakchalarga nusxalandi. Agar nusxa ko‘chirishda formuladagi kataklarning
manzillari avtomatik ravishda o‘zgargan bo‘lsa, unda E1 va E3 katakchalarning son
giymatlari nechaga teng bo‘ladi?

A s c o & BARCHA IMTIHON JAVOBLARINI

oo e e xed e |7 ME/USTOZ TELEGRAM KANALI
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1. “PhotoShop” kanallari va filtrlari hagida tushuntirish bering.

"Photoshop" kanallari va filtrlari tasvirni tahrir qilishda foydalaniladigan muhim vositalardan
hisoblanadi. Kanallar tasvirning chizilgan yoki o'zgartirilgan gismlarini yoritish uchun
ishlatiladi. Filtrlar esa tasvirlarni tahrir gilish uchun amalga oshirilgan biron bir amallarni
qayta ishlovchi, tahrir gilish va shakllarni go'shish uchun qo'llaniladigan vositalardir.
Kanallar "Photoshop"da tasvirni yaratishda, tahrir qilishda va ko'rishda foydalaniladi. Har bir
rang (qizil, yashil va ko'k) o'zining bir necha kanallarga ega bo'lishi mumkin. Masalan, tasvirni
tahrir gilishda, tasvirning bitta qismi uchun ayri-ayr1 kanallar yaratish va har bir kanal ustida
turli tahrirni amalga oshirish mumkin. Kanallar tasvirning texnik yorug'ligini yoki
haydovchilik yorug'ligini aniglash uchun ham foydalaniladi.

Filtrlar esa tasvitlarni tahrir qilish va yaratishda qo'llaniladigan vositalardir. Filtrlar ko'p xil
turdagi amallarni bajarish uchun foydalaniladi, masalan, tashqi ko'rinishni o'zgartirish, tasvirni
blur qilish yoki gayta ishlanishlarini bajarish kabi. Filtrlar qo'llanishidan oldin tasvir qayta
saglanadi, shuning uchun ularni boshqga funksiyalarga qo'shish va tasvirlarni tahrir gilishning
bir gismiga tatbiq gilish mumkin.

2. Quyidagi shartlarga ko‘ra kvadrat tenglama ildizlarini topuvchi dastur tuzing. ( D>0,
D=0, D<0).

import math

# Tenglama koeffitsientlarini olish

a = float(input("a = "))

b = float(input("b = "))

¢ = float(input("c = "))



# Diskriminanti hisoblanadi
D = b**2 - 4*a*c
# Agar D>0 bo'lsa 2 ildiz bor
ifD > 0:
x1 = (-b + math.sqrt(D)) / (2*a)
x2 = (-b - math.sqrt(D)) / (2*a)
print(f'Tenglamaning 2 ta ildizi mavjud: x1 = {x1}, x2 = {x2}")

# Agar D=0 bo'lsa bir ta ildiz bor
elif D == 0:
=-b/(2*a)
print(f"Tenglamaning bir ta ildizi mavjud: x = {x}")

# Agar D<0 bo'lsa ildizsiz
else:

print("Tenglama ildizsiz")
3. Elektron jadvalning C2: F6 va B3: B6 diapazonlari katakchalarida ragamlar
joylashgan (rasm). Al katakchada =E$4+$D5 formula yozilgan. B1 katakchaga Al
katakchadan nusxa ko‘chirgandan so‘ng B2 katakchada qanday giymat hosilbo‘ladi?

JA 8 c D E F

£ 2 3 a 5
3 2 2 2 6 8
4 3 3 6 9 12
5 4 4 8 12 16
6 5 5 10 15 20
= E$4 + $D6

Javob: E$4 + $D6
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1. “PhotoShop”da mo‘yqalam va galam bilan ishlashni tushuntiring.

"Photoshop"da mo'yqalam va qalam bilan ishlash imkoniyati mavjud. Bu vositalar tasvirlarni
tahrir gilishda, qo'shimcha ranglarni qo'shishda yoki o'ratishda, yashil shaklda belgilashda va
boshgqalar kabi ko'p xil magsadlar uchun ge'llaniladi.

Mo'yqalam "Photoshop"da ko'p yo'l bilan yaratilishi mumkin. Bitta yo'li esa, "Brush Tool" ni
ochish va "Brush Preset Picker" dan mo'yqalamni tanlashdir. Mo'yqalam shakli, o'lchami va
rangi o'zgartirilishi mumkin. Mo'yqalam shakli "Photoshop"ning asosiy versiyalarida doimiy
ravishda mavjud bo'lgan yaxlit mo'yqalam bilan bir xil emas. Bu yo'lda mo'yqalam shakli va
o'lchami tahrir gilinishi mumkin. '

Qalam esa, moslashuvchanligi oshirilgan yoki keskin shaklda chizish uchun foydalaniladi.
Qalamni yaratish uchun "Pen Tool"ni foydalanish mumkin. Qalam yaratilgandan so'ng, u
tasvirga joylashtirilishi va shakli o'zgartirilishi mumkin. Qalam "Shape Tool" bilan ham
ishlatilishi mumkin, bu usulda shaklga moslashuvchanlik go'shish mumkin.

2. Ikkita ikki xonali butun son kiritilganda ularning yig‘indisini 5 ga karrali yokikarrali
emasligini aniqlovchi dastur tuzing.

numl = int(input("Birinchi sonni kiriting: "))

num?2 = int(input("lkkinchi sonni kiriting: "))



sum = numl + num?2

if sum % 5 == 0:
print(f'Kiritilgan sonlarning yig'indisi 5 ga karrali: {sum]")
else:
print(f"Kiritilgan sonlarning vig'indisi 5 ga karrali emas: {sum}")
MS Excel. Agar Al=22; A2=10; A3=I8 bo‘lsa, A6 katakchadagi quyidagiformula natijasini
toping: =SRZNACH(A1:A3)+ STEPEN(A3;2)*A1-A3?
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1. “PhotoShop”da tasvirga geometrik shakllarni go*yishni tushuntiring.
"Photoshop"da tasvirga geometrik shakllar gqo'shish amali matn, mozaika, quti, to'g'ri chiziqli
shakllar, doira va boshqgalar kabi turli xil shakllar yaratishga yordam beradi. Geometrik
shakllar go'shish uchun quyidagi gadam-lar ko'rib chigamiz:
1. "Shape Tool"ni tanlang: "Rectangle Tool", "Ellipse Tool" va "Polygon Tool" kabi geometrik
shakllar yaratishda ko'p foydalaniladigan vositalar bu ilovalarda mavjud.
2. Shartnoma ni o'rnatish: Shartnoma ko'rsatmalari tasvir ustida turgan paytda yaratilishi
mumkin. Shartnoma ni yaratish uchun "Custom Shape Tool"ni ishlatish mumkin.
3. "Shape Properties"ni o'zgartirish: yaratilgan geometrik shakl ustida kerakli tahriratlar
ko'rsatilishi uchun "Shape Properties" panelini ochish kerak. Shu panel orqali shakl o'lchamini,
rangini va boshqa xususiyatlarini o'zgartirishingiz mumkin.
4. "Path Selection Tool"ni ishlatish: yaratilgan shaklni belgilab, uni tahrirlash uchun "Path
Selection Tool"ni ishlatish mumkin. Shu orqali shaklIni ko'chirish, o'lchamini o'zgartirish va
ko'p qo'shimcha o'zgartirishlarni gilishingiz mumkin.
5. Shaklni gabul qilish: yaratilgan geometrik shaklni tasvirga joylashtirish uchun "Shape
Layer" yoki "Path"ni tasvirga aylantirishingiz mumkin.
Geometrik shakllarni qo'shish "Photoshop”da tahrir gilish jarayonida wva yangi tasvir
yaratishda juda foydali bo'ladi.
2. Ikkita aylana markazlarining ixtiyoriy (x1,y1) va (x2,y2) koordinatalari va rl var2
radiuslari berilgan. r1<r2 shart asosida bu aylanalarning o‘zaro joylashuvini aniqlovchi
dastur tuzing.
import math

xI = float(input( "Birinchi aylananing markazining x koordinatasini kiriting: "))
vl = float(input("Birinchi aylananing markazining y koordinatasini kiriting: "))
rl = float(input("Birinchi aylananing radiusini kiriting: "))

x2 = float(input("Ikkinchi aylananing markazining x koordinatasini kiriting: "))
v2 = float(input( "lIkkinchi aylananing markazining y koordinatasini kiriting: "))
12 = float(input("lkkinchi aylananing radiusini kiriting: "))

distance = math.sqri((x2-x1)**2 + (y2-yl)**2)

| BARCHA IMTIHON JAVOBLARINI
b i T.ME/USTOZ TELEGRAM KANALI

print( "Avlanalar bir-biridan alogador")

elif distance == rl+r2: ORQALI YUKLAB OLING!




print( "Aylanalar fagat chiggan nugta uchun alogador”)
elif distance < r2-rl:
print("Birinchi aylanalar ikkinchisida joylashgan")
elif distance == r2-rl:
print( "Aylanalar bir-biridan ichki kesishgan")
else:
print( "Avlanalar bir-biridan kesishgan")
3. Svetoforda yo‘Ini kesib o‘tish algoritmini (blok sxemasini) tuzing,.
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1. “PhotoShop”da tasvirga vektorli obyektlarni qo*yishni ko‘rsating.
"Photoshop'da tasvirga vektorli obyektlar go'shish uchun quyidagi gadam-larni bajarishingiz
mumkin:
I. "Shape Tool"ni tanlang: "Rectangle Tool", "Ellipse Tool” va "Custom Shape Tool" kabi
vositalar "Shape Tool" bo'limida mavjud.
2. Vektor obyektini tanlang: tanlagan "Shape Tool"ni tasvir ustida o'ng tarta bosishingiz bilan
vektor obyekti yaratishingiz mumkin.
3. Vektor obyektini tahrirlash: Vektor obyektlarni tahrirlash uchun "Path Selection Tool"ni
ishlatishingiz mumkin. Bu vosita orgali obyekt tanlanib, o'lchamini o'zgartirish va yo'nalishini
aniglash mumkin.
4. "Vector Mask" yaratish: Vektor obyektni o'chirish, joylashtirish yoki yo'nalishini
o'zgartirishni xohlagan paytda "Vector Mask"ni ishlatishingiz mumkin. Shu orqali
o'zgartirishlarni tez va aniq tarzda amalga oshirishingiz mumkin.
5. "Shape Properties"ni o'zgartirish: Vektor obyektning xususiyatlarini o'zgartirish uchun
"Shape Properties" panelini ochish va o'zgartirishlari gilishingiz mumkin.
Vektor obyektlar tasvir tahrirlashda aniq, sifatli va nisbiy to'g'ri koordinatalarda ishlaydi.
Buning sababi, vektorli obyekt yaratish tasvirlarni profesionallik darajasiga oshiradi va
ulardan ko'proq foydalanish imkonini beradi.
2. Foydalanuvchi kiritadigan A va B sonlarning kubini hisoblovchi dastur tuzing.
a = float(input("a ni kiriting: "))
b = float(input("b ni kiriting: "))

a_citbe = a ** 3



b _cube = b ** 3

print(f‘a ning kubi: {a_cube]")

print(f"b ning kubi: {b_cube]")

3. ax’+bx+c=0 kvadrat tenglama ildizlarini hisoblovchi algoritmni (blok-sxemasini)
tuzing.

Boshlash
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1. “PhotoShop”da tasvirga matn joylashtirishni tushuntirib bering.

"Photoshop"da tasvirga matn joylashtirish uchun quyidagi gadamlarni bajarishingiz kerak:

[. "Text Tool"ni tanlang: Bu vosita tasvir ustida matn joylashtirishingiz mumkin. "Text Tool"
bilan ganday matn tahrirlashni ko'rsatuvchi galamning turini (font) va o'lchamini tanlay olasiz.
2. Matnni joylashtiring: Matnning joylashuvi uchun yengil, to'g'ri va aniq kKoordinatalarda
joylashtirishingiz kerak. "Text Toel" ni tanlashingizdan so'ng, matnni joylashtirish uchun
kursorni tasvir ustida o'ng tarta bosib turishingiz kerak. Bu orqali joylashgan matn qutilar
ko'rinishida tasvir ustida ko'rsatiladi.

3. Matn xususiyatlarini o'zgartirish: Matning shaklini va rangini o'zgartirish uchun "Character"
panelidan foydalanishingiz mumkin. Bu panel orqali galam (font) turini, hajmini, rangini va
qo'shimcha xususiyatlarini o'zgartirishingiz mumkin.

4. Matn shaklini o'zgartirish: "Paragraph” paneli yordamida matnni o'lchamini, gqatlamini va
joylashuvi hagida batafsil sozlash imkonini beradi.

5. Matn gatorlarini birlashtirish: "Type Tool" bilan tekshiruv va tahrir gilishingiz mumkin.
Matndagi xatolarni ko'rsatuvchi chizigga bosib. matnni tahrir qilishingiz mumkin.

Matn joylashitirish yordamida, tasvir ustida yagona, o'ziga xos matnli elementlar, logo yoki
yagona, matnli tasvirlar yaratishingiz mumkin.

2. Parallelogrammning yuzi va perimetrini hisoblovchi dastur tuzing.

a = float(input("a ni kiriting: "))

b = float(input("b ni kiriting: "))

h = float(input("h ni kiriting: "))

T¢




area=h *b
perimeter = (a + b) * 2

print(f"Paralelogramning yuzi: {areal")

print(f"Paralelogramning perimetri: {perimeter}")

3. Algoritmning blok-sxemasidan foydalanib, Y funksiya giymatlarini X=0; 2; 8
bo‘lganda hisoblang:

C Boshland| =3

/xititibir; X 7

[ z-8'x X soni kvadrat, giymat A ga beriladi:

 — - A soni kvadrat, giymat B ga beriladi;

{ S % A va B yig'iladi va n C ga beriladi;
2=2Z-1 B giymati |1 ga oshiriladi:

| Y=3°x ' Cqiymati D ga bo'linadi va Y ga beriladi;
vviz 1 Natijada Y olinadi.
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1. Web-sayt va web-dizayn tushunchalari haqida aytib bering.

Web-sayt, internet orqali ko'rishga mo'ljallangan bitta yoki bir nechta web-sahifalardan iborat
bir gator axborotdagi to'plamdir. Bu sahifalar bilan, har ganday muammolarni yechish, e'tibor
qozonish, ma'lumot almashish va boshga ko'rsatmalarni bajarmogq mumkin. Web-saytlar,
kompyuterlar, smartfonlar, planshetlar va boshqa qurilmalar orqali foydalanish mumkin.
Web-dizayn esa web-saytlarni dizayn qilish, ularga bir necha xususiyatlar qo'shish va
ko'rsatishni o'rganishdir. Web-dizayn odatda tasvir, matn va boshqga turlardagi kontentlarni
web-sahifalarda ko'rsatish uchun boshqa turlardagi texnologiyalardan foydalanadi. Bu
texnologiyalar HTML, CSS, JavaScript va boshqa ko'plab texnologiyalarni o'z ichiga oladi.
Web-dizayn sahifalarni o'zgartirish, optimallashtirish va foydalanuvchilarni tasdiglashni o'z
ichiga olgan web-menejmentiga garab amalga oshiriladi.

Web-dizaynning boshga muhim aspektlari shu jumladan SEO (Search Engine Optimization),
veb-saytning ishlab chiqarish tajribasi (User Experience) va responsive dizayn (responsive
design) kabi qobiliyatlar hisoblanadi. Bu tushunchalar to'g'ri amalga oshirilganda, saytlar
ko'proq oqiladi va ommaviy foydalanuvchilar uchun foydali bo'ladi.

2. Kvadratning yuzi va perimetrini hisoblovchi dastur tuzing.

a = float(input("Kvadrat tomon uzunligini kiriting: "))

# Kvadratming yuzi
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P=4*a
print( "Kvadratning perimetri:", P)
3. Ma’lum bir funksiya giymatini hisoblovchi ushbu blok-sxema asosida masala




shartini tiklang: funksiya qiymatini hisoblovchi fermulani yozing,
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1. Macromedia Dreamweaver 8 dasturi interfeysi va uning uskunalar panelinihagida
ma’lumot bering.
Macromedia Dreamweaver 8, veb-sahifalarni tuzish uchun professional dastur hisoblanadi va
o‘zida ko‘plab asboblar jamlangan. Dastur interfeysi ko*proq Adobe Photoshop, Illustrator va
boshga Adobe dasturlari kabi vosita gilib ishlatiladi. Dreamweaver 8 asosiy interfeysining
yugqorisida menular paneli, vositalar paneli va asboblar paneli joylashgan.
Menular paneli, dastur interfeysining yuqori gismida joylashgan va sahifalarni tuzishning
asosiy qismlariga kirish uchun mo'ljallangan. Bu yerda fayl ochish, sahifa yaratish, html, css,
javasceript va boshga vositalarga kirish imkoniyati mavjud.
Vositalar paneli, dastur interfeysining o'ng tomonida joylashgan va asosiy vositalarni tahrir
qilish, shuningdek, rasm, mediya va boshqa komponentlarga kirish imkoniyatini beradi.
Asboblar paneli esa dasturning eng kuchli gismlaridan biri hisoblanadi, shuning uchun u
interfeysning chap tomonida joylashgan va kerakli asboblar yig*inlarini tashkil giladi.
Barcha uskunalar paneli o‘zaro bog‘liq va o‘z-0°zidan foydalanish imkoniyatini beradi,
bundan tashqari Dreamweaver 8 alohida vositalarga, masalan, kodlar, stil saytlari va
shablonlarga ega. Bularni yuklab olish va o*rnatish imkoniyatlari mavjud.
2. [-3;3] oraliqgda quyidagi funksiya uchun x ning butun giymatlarini hisoblovchidastur

tuzing: y=|x| + 3\fx2 -25—(1=x%);

3. Nargiza onasiga 10 seniya davomida 200 ta belgidan iborat xabar yuboerdi. Bundahar
bir belgi 5 bitdan iborat. Axborot uzatish tezligini aniglang.

200 * 5 = 1000 bit

1000 bit/10 sek = 100 bit/sek = 100 bod

Javob: 100 bod
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1. Macromedia Flash 8 dasturida animatsiyalar yaratish hagida tushuntiring.
Macromedia Flash 8, interaktiv veb-animatsiyalarni yaratish uchun moslashtirilgan dastur
hisoblanadi. Bu dastur, animatsiyalarni tasarlash, tahrir qilish va joriy etish uchun bir qator
uskunalar va vositalarni tagdim etadi.
Animatsiyalar yaratish uchun, birinchi gadam Adobe Flash dasturi ochiladi va yangi loyiha
yaratiladi. Loyni yaratishdan keyin, asosiy animatsiya sahifasi ochiladi va keyingi qadamlarda
animatsiya elementlari qo‘shiladi.



Animatsiyalar yaratish uchun foydalaniladigan asosiy vositalar o‘zgaruvchanliq, solishtirish
va shakllantirish gobiliyatiga ega. Keyingi animatsiyalarni yaratishda, keyingi kadamlarda
to‘plangan elementlar birlashmasi mumkin.

Flash 8 dasturi, animatsiyalar uchun gaynaq kodini yozishga imkon beradi, shuningdek,
animatsiya sahifasini rasm formatida saqlash, olingan animatsiyalarni swf formatida eksport
gilish va boshqa turli formatlarga saqlash imkoniyatini taqdim etadi.

Flash 8 dasturi animatsiyalar yaratishda xavfsizlik qidiruvlari va asboblariga ega, shuningdek,
shuningdek, tushuntirilgan vositalar yordamida animatsiyalar yaratish qulayligini ta’minlaydi.
2. Geron formulasi yordamida uchburchakning yuzini hisoblaydigan dastur tuzing,.
import math

a = fleat(input("Uchburchakning birinchi tomonini kiriting: "))

b = float(input("Uchburchakning ikkinchi tomonini kiriting: "))

¢ = float(input("Uchburchakning uchinchi tomonini kiriting: "))

p=(a+b+c¢)/2

S = math.sqrt(p * (p-a) *(p-b) *(p-c))

print(f"Uchburchak yuzi: {S}")

3. 2000 Kbayt hajmli fayl 30 soniya ichida ma’lum bir ulanish orqali uzatiladi. Ushbu
ulanish orqali 12 soniya ichida uzatilishi mumkin bo‘lgan fayl hajmini (Kbayt) aniglang.
2000 /30 = 66,67 Kbayt/sek
12 * 66,67 = 800 Kbayt
Javob: 800 Kilobayt
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